
 

 

 

 

   

 

  

 

 

 

 

ELECTRONIC STAFF RECORD 
 

 

MM-0100 – Organisation Site IT, Printer and Network 
Infrastructure Readiness 
 

Information classification: RESTRICTED - IBM ESR Programme Staff & NHS ESR 

Programme Staff and NHS Employing Organisation ESR Users only 

 

Owner: Paul Spooner 

Author: Oluwaseyi Abolarin 

Creation date: 26th October 2004 

Date of latest update: 10th December 2025 

Version number:       46.0 

 

Approvals: 

Name Chris Moorley 

Title NHS ESR Head of Operations and Development 

Date  

 

Name Davey Banks 

Title IBM ESR Service Director 

Date  

 



 

 

MM-0100 – Organisation Site IT, Printer and Network Infrastructure Readiness v46.0 Page 2 of 41 

RESTRICTED - IBM ESR Programme Staff & NHS ESR Programme Staff and NHS Employing Organisation 

ESR Users only 

Document Control 

1.1 Change Record 

Date Author Version Change Reference 

10/04/13 Lucy Trotter V16.0 New Survey results, updated 
reviewers, JRE Security Settings 
added to Appendix B. 

12/02/14 Helen Grant V17.0 Survey results updated. 
Supported versions updated. 

05/03/15 Rebecca Harrison V18.0 Removed references to SSL.   

01/10/2015 Rebecca Cunningham V19.0 Document renamed from M-0100 
to  MM-0100. 

30/03/2016 IBM PMO V20.0 Update survey results. 

12/06/2016 Bryan Wood V21.0 Minor updates. 

09/08/2016 IBM PMO V22.0 Minor updates. 

14/10/2016 IBM PMO V23.0 Issued for sign off. 

21/03/2017 IBM PMO V24.0 Updated survey results. 

27/04/2017 Bryan Wood V24.1 Document updated for new portal 
access and extended support 
model. 

14/07/2017 Bryan Wood V24.2 Document updated following 
review. 

25/09/2017 David Booth V24.3 Tidied document change record, 
updated supported versions for 
R37. 

14/11/2017 Jade Collins V24.4 Updated list of reviewers. 

04/12/2017 Bryan Wood V24.5 Document updated following 
review. 

08/12/2017 Bryan Wood V24.6 Document updated following 
review. 

21/12/2017 Bryan Wood V24.7 Document updated following 
review. 

03/01/2018 David Booth V25.0 Updated to 25.0 for approval. 

31/01/2018 Bryan Wood V25.1 Document restructured for 
simplification and also updated 
the survey results. 

23/03/2018 Bryan Wood V25.2 Document updated following 
review. 

06/04/2018 Bryan Wood V25.3 Document updated following 
review. 



 

 

MM-0100 – Organisation Site IT, Printer and Network Infrastructure Readiness v46.0 Page 3 of 41 

RESTRICTED - IBM ESR Programme Staff & NHS ESR Programme Staff and NHS Employing Organisation 

ESR Users only 

17/04/2018 Bryan Wood V25.4 Document updated following 
review. 

19/04/2018 Bryan Wood V26.0 Updated to 25.0 for approval. 

14/06/2018 Bryan Wood V26.1 Updated with Windows 10 survey 
results. 

19/06/2018 Tim Smith V26.2 Removed Chris Price as a 
reviewer of this document.  

28/06/2018 Bryan Wood V26.3 Document updated following 
review and Chris Price included 
as a reviewer. 

11/07/2017 Jade Collins V27.0 Baselined for approval 

17/09/2018 Bryan Wood V27.1 Change from N3 to HSCN. 

02/10/2018 Bryan Wood V27.2 Document updated following 
review. 

24/10/2018 Bryan Wood V27.3 Document updated following 
review. 

16/11/2018 Harry Collinge V28.0 Baselined for Approval 

26/03/2019 Bryan Wood V28.1 Changed to Reflect new versions 
of software that will be supported. 

21/05/2019 Simron Dhariwal V28.2 Updated Reviewers 

17/04/2019 Bryan Wood V28.3 Document updated following 
review. 

20/05/2019 Bryan Wood V28.4 Document updated following 
review. 

24/05/2019 Bryan Wood V28.5 Document updated following 
review. 

05/06/2019 Harry Collinge V29.0 Baselined for Approval  

29/10/2019 Bryan Wood V29.1 Updated for planned changes 

27/11/2019 Bryan Wood V29.2 Document updated following 
review. 

28/11/2019 Megan Jackson V29.3 Updated list of reviewers and 
roles 

05/12/2019 Megan Jackson V30.0 Baselined for Approval 

22/01/2020 Bryan Wood V30.1 Changed to Reflect new versions 
of software that will be supported. 

06/03/2020 Bryan Wood V30.2 Document updated following 
review. 

20/03/2020 Bryan Wood V31.0 Baselined for approval 

22/09/2020 Bryan Wood V31.1 Changed to Reflect new versions 
of software that will be supported. 

14/10/2020 Max Moscrop V31.2 Updated reviewers list 



 

 

MM-0100 – Organisation Site IT, Printer and Network Infrastructure Readiness v46.0 Page 4 of 41 

RESTRICTED - IBM ESR Programme Staff & NHS ESR Programme Staff and NHS Employing Organisation 

ESR Users only 

21/10/2020 Bryan Wood V31.3 Document updated following 
review. 

15/12/2020 Bryan Wood V31.4 Document updated following 
review 

30/12/2020 Bryan Wood V31.5 Document updated following 
review 

06/01/2021 Bryan Wood V31.6 Document updated following 
review 

12/01/2021 Bryan Wood V31.7 Document updated following 
review 

19/01/2021 Simron Dhariwal V32.0 Baselined for Approval 

03/08/2021 Bryan Wood V32.1 Changed to Reflect new versions 
of software that will be supported. 

06/09/2021 Abbie Birch V32.2 Updated reviewers 

17/09/2021 Bryan Wood V32.3 Document updated following 
review 

19/10/2021 Bryan Wood V32.4 Document updated following 
review 

28/10/2021 Abbie Birch V33.0 Baselined for approval 

05/05/2022 Silvina Ré V33.1 Quarterly review 

26/05/2022 Abbie Birch V33.2 Updated reviewers 

08/06/2022 Silvina Ré V33.3 Document updated following 
review 

13/06/2022 Silvina Ré V34.0 Baselined for Approval  

21/06/2022 Silvina Ré V34.1 Quarterly review 

30/08/2022 Silvina Ré V34.2 Updated reviewers 

13/09/2022 Silvina Ré V35.0 Baselined for Approval 

10/10/2022 Silvina Ré V35.1 Change the supported version of 
JRE and remove references to 
the JWS portlet. 

18/10/2022 Silvina Ré V35.2 Document updated following 
review. 

24/10/2022 Silvina Ré V36.0 Baselined for Approval 

02/11/2022 Silvina Ré V36.1 Removed IE Active X guidance 
and added guidance for multiple 
browser windows 

07/12/2022 Silvina Ré V36.2 Document updated following 
review 

09/12/2022 Silvina Ré V37.0 Baselined for Approval 

29/03/2023 Silvina Ré V37.1 Quarterly review 

28/04/2023 Silvina Ré V37.2 Document updated following 
review 



 

 

MM-0100 – Organisation Site IT, Printer and Network Infrastructure Readiness v46.0 Page 5 of 41 

RESTRICTED - IBM ESR Programme Staff & NHS ESR Programme Staff and NHS Employing Organisation 

ESR Users only 

04/05/2023 Silvina Ré V38.0 Baselined for Approval 

01/11/2023 Silvina Ré V38.1 Quarterly review 

24/11/2023 Silvina Ré V39.0 Baselined for Approval 

08/03/2024 Oluwaseyi Abolarin V39.1 Quarterly review 

25/03/2024 Oluwaseyi Abolarin V39.2 Document updated following 
review 

08/04/2024 Oluwaseyi Abolarin V40 Baselined for Approval 

24/04/2024 Oluwaseyi Abolarin V40.1 Quarterly review 

01/05/2024 Kacy Marshall V40.2 Updated NHS reviewers ready for 
review 

02/05/2024 Kacy Marshall V40.3 Error in reviewer list corrected  

10/05/2024 Oluwaseyi Abolarin V40.4 Document updated following 
review 

14/05/2024 Kacy Marshall V41.0 Baselined for Approval 

01/08/2024 Oluwaseyi Abolarin V41.1 Quarterly review 

14/08/2024 Kacy Marshall V41.2 Updated ACT approver 

29/08/2024 Oluwaseyi Abolarin V41.3 Document updated following 
review 

29/08/2024 Oluwaseyi Abolarin V42.0 Baselined for Approval 

28/11/2024 Oluwaseyi Abolarin V42.1 Quarterly review 

16/12/2024 Oluwaseyi Abolarin  V42.2 Document updated following 
review 

20/12/2024 Oluwaseyi Abolarin V43.0 Baselined for Approval 

01/06/2025 Oluwaseyi Abolarin V43.1 Quarterly review 

13/06/2025 Oluwaseyi Abolarin V43.2 Document updated following 
review 

07/07/2025 Oluwaseyi Abolarin V43.3 Document updated following 
review 

21/07/2025 Oluwaseyi Abolarin V43.4 Document updated following 
review 

30/07/2025 Nazish Jujara V44.0 Baselined for approval  

18/09/2025 Oluwaseyi Abolarin V44.1 Quarterly review 

16/10/2025 Oluwaseyi Abolarin V44.2 Document updated following 
review 

24/10/2025 Oluwaseyi Abolarin V45.0 Baselined for approval 

18/11/2025 Oluwaseyi Abolarin  V45.1 Quarterly review 

08/12/2025 Oluwaseyi Abolarin V45.2 Document updated following 
review 

10/12/2025 Hannah Adegun V46.0 Baselined for approval 

 



 

 

MM-0100 – Organisation Site IT, Printer and Network Infrastructure Readiness v46.0 Page 6 of 41 

RESTRICTED - IBM ESR Programme Staff & NHS ESR Programme Staff and NHS Employing Organisation 

ESR Users only 

1.2 Reviewers 

Name Position 

Mark Lambert IBM ESR Development Manager 

Chris Borchard IBM ESR Operations Support Manager 

Steve Kelly IBM ESR Chief Architect 

Tony Boles IBM ESR Technical Services Manager 

Chetan Mistry IBM ESR Application Support Manager 

Sam Wright NHS ESR Development Advisor 

Chris Holroyd NHS ESR Development Advisor 

Matthew Lye NHS ESR Assistant Development Advisor 

Bryan Wood NHS ESR Technical Team Leader 

 

1.3 Distribution / Location 
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Version 
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1.4 References 
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1.5 Glossary 

Term Definition 
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2 Basic Desktop PC Software Requirements 

2.1 Supported Software Versions 

Software recommended when accessing ESR is listed below. The versions listed are 

those supported by the ESR Programme. The table below is correct as at ESR Release 65 

(June 2025). Future scheduled changes to the supported software are listed in section 7. 

The table contains all of the software recommended to access all aspects of ESR, 

however not all users will require all of the software if they only access specific parts of 

ESR (for example, ESR Self Service users, accessing via the internet, do not require the 

items indicated with an * in the list). 

The supported browsers are Edge and Chrome. ESR is  accessible via Edge and Chrome 

and details of how to configure access for the users in your Organisation is in Appendix G 

Section 14. 

Requirement Supported Version 

Operating System Microsoft Windows 11 23H2 

Internet Browsers Microsoft Edge ** 

Chrome 

104 

Java Runtime Environment 

(JRE) * 

Oracle JRE 1.8.0_4313 

Office Software * Microsoft Office*** 2021 

Smartcard Reader 

Software(smartcard users only) * 

NHS Identity Agent 2.3 

PDF Reader Adobe PDF Reader Latest 

 

2.2 Alternative Versions 

NHS Organisations that use ESR are responsible for determining the software deployed 

across their own IT estate. They will need to balance the software requirements of the 

systems they deploy within their organisation including ESR, against the requirements for 

IT security and Information Governance. It is recommended that sites use the latest 

version of JRE to pass the NHS England Cyber Essentials test. Oracle advise that newer 

versions of the 1.8 codeline of JRE should be backwards compatible, so running a later 

version than the one that ESR has been tested against should not present an issue.  

Where an organisation chooses to run different software versions to those shown above, 

they are recommended to run at least one “base” workstation on the current supported 

versions. The base workstation should then be used to replicate any ESR issues before a 

related support call is logged with the ESR Service Desk. The ESR Support Team will then 
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work with the organisation to resolve the issue on the base workstation. Once the reason 

and resolution of the access issue has been identified, the NHS Organisation can make a 

judgement on how best to deploy any required change. 

2.3 Virtualisation / Thin Clients 

On the basis Oracle does not currently certify any of their e-Business suite products to run 

with virtualisation, the ESR supplier and the NHS central team are unable to support this 

configuration for ESR. Wherever this configuration is used, the ESR supplier will only 

provide support on condition the fault can be reproduced outside the virtual environment 

on a PC specification meeting the ESR requirements.  

2.4 JRE Licences 

In 2019, Oracle introduced licensing arrangements for Java and JRE for users of non 

Oracle systems which meant that there is a licence fee for Java. However users of 

systems that Oracle supplies such as ESR (built on the Oracle HRMS e-Business suite) 

which uses Java are entitled to a free JRE licence and access to any Oracle Java SE 

Updates. Please see Appendix D section 10.2 for a further explanation of this and how it 

works. 
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3 Addressing 

A number of addresses are in use to access ESR and related systems. These are listed in 

the sections below. 

3.1 Production 

Address Ports Description 

https://my.esr.nhs.uk 443 Main access route to ESR 

including Self Service. 

https://servicedesk.esr.nhs.u

k 

443 ESR service desk 

https://esrobia.esr.nhs.uk/an

alytics/saw.dll?bieehome 

for data warehouse users. 

443 ESR BI – users of 

my.esr.nhs.uk addresses no 

longer require this url. 

https://trustedurl.national.ncr

s.nhs.uk/ 

443 For smartcard users only. It 

is used for connectivity 

testing. 

https://cdn.esr.nhs.uk 443 for accessing cached static 

files 

 

3.2 Training / Familiarisation 

Address Ports Description 

https://my-epro.esr.nhs.uk 443 EPRO familiarisation environment. 

https://my-training.esr.nhs.uk/ N/A 

  

You organisation 

will need to 

ensure they are 

allowing 

connections on 

HTTPS to my-

training.esr.nhs.u

k 

(194.203.48.171) 

via HSCN. 

TPLY sandbox environment for 

training purposes. 

https://cdn.esr.nhs.uk/
https://nhsbsauk-my.sharepoint.com/personal/oluab_nhsbsa_nhs_uk/Documents/Documents/MM-0100/v41.1-v42/MM-0100%20-%20Organisation%20Site%20IT%20Printer%20and%20Network%20Infrastructure%20Readiness%20v41.1.docx
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http://my-

train.esr.nhs.uk:8064/OA_HTM

L/AppsLocalLogin.jsp 

9064 Forms traffic 

 

3.3 Other Related Addresses 

e-Learning content is hosted by multiple suppliers and these can often change. A list of 

domains used by national e-Learning suppliers is provided at the address below which is 

updated in line with changes to e-Learning suppliers or the domains that they use to host 

e-Learning. 

https://my.esr.nhs.uk/dashboard/web/esrweb/e-learning-technical-information 

https://my.esr.nhs.uk/dashboard/web/esrweb/e-learning-technical-information
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3.4 IP Addressing 

ESR is visible to HSCN on the subnet 62.130.47.32/27. The recommended security policy 

below is designed to allow for changes in the IP addressing of the live service, either for 

administrative/technical reasons or in the event of a switch to the DR system. 

 

Source Address Destination 

Address 

Destination Port Notes 

Your network(s) 62.130.47.32/27 

194.203.48.0/24 

194.203.48.99 

194.203.48.100 

http, https, tcp high 

ports greater than 

1024 

(tcp/>1024) 

Allows connections 

from organisation’s 

chosen network(s) 

to the ESR hosts at 

the production and 

DR sites. 

62.130.47.32/27 

194.203.48.0/24 

10.129.117.0/27 

10.129.117.128/27 

Your ftp server(s) ftp Allows ftp 

connections for 

delivery of finance 

interface files 

(necessary if you 

receive these files 

direct). 

62.130.47.32/27 

194.203.48.0/24 

Your SMART 

devices 

tcp/3001, tcp/9100, 

tcp/9101 

Allows connections 

from SMART 

servers back to 

your site. Used only 

by organisations 

that use SMART 

Time & Attendance 

and Rostering 

systems. 

194.61.248.0/24 Your ftp server(s) ftp Allows ftp 

connections for 

delivery of finance 

interface files 

(necessary if you 

receive these files 

direct). 

 

Alternatively if the firewall policy rules recommended by the ESR supplier do not meet 

local security standards, then a specific set of TCP ports can be opened for ESR 

environments. A table of the ESR environments with the associated ports required is 
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provided in section 2, the table is subject to revision and organisations should consult the 

latest list issued with each version of this document. 

The table below includes port numbers for connections for ESR interfaces. 

 

 

Environment Usage Address TCP Ports 

Inbound from ESR Hosts 62.130.47.32/27 and 194.203.48.0/24 

Secure File 

Transfer 

(FTPS) 

General Ledger 

& Other Non 

Core Interfaces 

N/A 21 and 20 -100  

contiguous ports 

within 49152-65535 

Secure File 

Transfer 

(SFTP) 

General Ledger 

& Other Non 

Core Interfaces 

N/A 22  supported only 
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4 Browser Properties Configuration 

4.1 Security 

4.1.1 Security Zones 

Internet Properties offers four different security zones to run applications through. The 

zone used is dependent on how you are accessing your site (Internet or Local Intranet) 

and set up within the zones themselves (Trusted sites & Restricted sites). 

Each zone has its own default security level that may need to be adjusted when accessing 

ESR.  

It is recommended that ESR is run through the 'Trusted Sites' zone, with a 'Medium' 

Security Setting. 

This can be achieved by following the steps below: 

Step Description 

1 
Type internet options in the search box on taskbar and choose Internet 

Options -> Internet Options -> Security tab -> Trusted Sites icon 

2 Set the 'Security Level for this Zone' to 'Medium' if it is not set already 

3 
Select Tools -> Internet Options -> Security tab -> Trusted Sites icon -> Sites 

button.  

4 
In the 'Add this Web site to the zone:' field, enter the address for ESR as 

detailed in section 2.  

5 Repeat the above step for each address used 

 

4.2 Popup windows 

ESR uses popup windows in a number of areas, therefore the popup blocker should be 

disabled or preferably the ESR addresses listed in section 2 should be added to the 

exceptions list. 

4.3 Proxy Configuration 

Depending on configuration, it may be required to update Internet properties settings to 

ensure ESR addresses are allowed to bypass a proxy server. The example below shows 

how this might be done. This may be deployed centrally for those organisations who 

manage settings centrally.  

A central policy for user access to e-Learning content is highly recommended as this 

mitigates against the risk of both incorrect entries being made, and the accidental deletion 

of existing entries, potentially impacting connectivity to important applications. 

 



 

 

MM-0100 – Organisation Site IT, Printer and Network Infrastructure Readiness v46.0 Page 16 of 41 

RESTRICTED - IBM ESR Programme Staff & NHS ESR Programme Staff and NHS Employing Organisation 

ESR Users only 

Step Description Screenshot 

1 Type internet options in the search 

box on taskbar and choose Internet 

Options → Internet Options → 

Connections Tab 

 

 

2 Select Lan settings  

3 Ensure the box for “bypass proxy 

server for local addresses” is 

checked then select Advanced button 

 

4 In the Exceptions section, enter the 

ESR addresses (from section 2) and 

any additional addresses for the 

content servers that may be 

accessed. Depending on the setup 

and the software used in your 

organisation, you may also need to 

enter the addresses for content 

servers. 
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Step Description Screenshot 

5 Click OK on the remaining screens to 

exit. Close all browser sessions 

before testing connectivity to ESR 

again. 

 

6 Where JRE does not inherit the proxy 

server exclusion rules from Internet 

Options, it is recommended to apply 

the same settings within JRE 

explicitly via the Java Control Panel. 

To access the Java Control Panel 

follow: 

Start>Settings>Control 

Panel>Java>General Tab>Network 

Settings. 

 

4.4 Using IE11 Compatibility Mode in Edge 

In Edge, IE Compatibility Mode should only be used as a work around where a full 

deployment of Edge with Java Web Start has not been achieved. 

Known issues with Compatibility Mode are: 

• Some e-learning content will not play 

• The browser will not offer to remember Passwords  

 

The correct solution is to deploy Edge in native mode as set out in Appendix G – 

Accessing ESR via Microsoft Edge. 

 

4.5 Enterprise Mode 

Enterprise Mode should not be used for any addresses used by ESR. If it is used, certain 

functions may not work correctly.  
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5 Networks 

Access to ESR is provided over the HSCN network; as such organisations will need to 

have access to an HSCN connection and also make sure that their local network  allows 

access to the domain https://cdn.esr.nhs.uk , which is hosted on internet and not within 

HSCN network.  In addition, ESR self-service users can access ESR over the internet 

(where agreed) avoiding the need for an HSCN connection, however core functionality 

such as HR and Payroll processing can only be accessed via the HSCN network . NHS 

organisations requiring connectivity to ESR will need to contact NHS England for advice 

on the most suitable network solution (https://digital.nhs.uk/health-social-care-network).  

 

5.1 Security 

In order to comply with policy on the secure transmission of personal or sensitive data over 

unsafe networks, encryption of ESR traffic (https using TLS) is employed between the 

ESR supplier Infrastructure and organisations.  

Access to ESR is supported via TLS versions 1.2 only. TLS 1.0 and 1.1 are not supported.  

Note: Organisations are recommended to disable TLS 1.0 in their browser settings.  

 

5.2 Firewalls and Proxy Servers 

The addresses listed in section 2 must be allowed to bypass any proxy servers or firewalls 

to ensure ESR can communicate successfully with the supplier’s servers. Any e-Learning 

content servers used may want to also bypass any proxy servers depending on 

configuration. Note: Where organisations experience any technical issues with ESR, it is 

recommended to bypass all proxies and firewalls as part of initial investigation efforts to 

ensure these are not the cause of the issues. See section 3.3 for IE proxy configuration 

steps. 

 

5.3 Interfaces 

Interface files such as the Finance (General Ledger) Interface are made available to 

organisations by means of File Transfer. File transfers between organisations and the ESR 

supplier are encrypted in accordance with security guidelines.  

The ESR supplier offers two encrypted file transfer protocols from the supplier Interface 

Hub: 

• FTP over TLS, also known as FTPS, the standard encryption extension to FTP 

• SFTP, the Open SSH protocol common on Linux and Unix systems 

 

 

https://cdn.esr.nhs.uk/
https://digital.nhs.uk/health-social-care-network
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NOTE: 

 It is considered the responsibility of the organisation to arrange their method of collecting 

these files. Organisations are also expected to have in place a disaster recovery 

alternative method of collecting these files in the event that the primary collection method 

fails for any reason, alongside their standard disaster recovery plans for connecting to the 

ESR system. 

5.4 Bandwidth 

ESR is a web-based application and therefore uses bandwidth in the same way any other 

website would, with the following highlights: 

• An allowance of at least 3KBPS per user should be made. 

• Upon first access of the ESR Portal, around 2MB of resources may be downloaded 

and cached. 

• Upon first access of ESR, around 5MB to 9MB may be downloaded and cached. 
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6 Hosting e-Learning 

To enable e-Learning content to communicate with ESR, a set of files called a SCORM 

adapter is required.  

Networks should be configured to enable communication with the national e-Learning 

servers as detailed in section 2. 

When hosting local content, if the organisation wishes to use SCORM adapters, a number 

of requirements must be met. These are detailed, along with further information and 

download links here. 

6.1 Connectivity 

Content servers will need to be able to communicate with:cc 

• https://my.esr.nhs.uk  (Production)  

• https://my-psup.internal.uk.com  (Production Support) 

If the e-Learning content server cannot communicate with these addresses, progress may 

not be saved when users play local e-Learning content. 

 

7 Microsoft Office Configuration 

Users of Word and Excel will require certain changes to be made to the security settings to 

enable Web ADI functionality to work. The following settings are required: 

• Select File → Options → Trust Center → Trust Center Settings, choose the 

“Disable all macros with notification” setting (note this is the highest setting for the 

Letters (Web ADI) functionality to work) 

• Select File → Options → Trust Center →Trust Center Settings → Macro Settings, 

check the check box for “Trust access to VBA project object model” and “Disable all 

macros with notification”.  

• Select File → Options → Trust Center →Trust Center Settings → File Block 

Settings check the check boxes for Open on all “Add-in Files” and “Templates”. 

 

 

https://my.esr.nhs.uk/dashboard/web/esrweb/e-learning-technical-information
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8 Appendix A – Scheduled Changes to Supported Software 

The following table lists 

the supported software 

components and their 

status for support in 

previous, current and 

future releases.  

R66 

Sep 25 

R67 

Jan 25 

R68 

Mar 26 

 

R69 

Jun 26 

Browser Edge + Chrome Edge + Chrome Edge + Chrome Edge + Chrome 

Firefox, Safari Firefox, Safari Firefox, Safari Firefox, Safari 

TLS 1.2 TLS 1.2 TLS 1.2 TLS 1.2 

Operating System Windows 11 

23h2 (64 bit) 

Windows 11 

24h2 (64 bit)  

Windows 11 

24h2 (64 bit) 

Windows 11 

24h2 (64 bit) 

Windows 11 

24h2 (64 bit)  

(TBC) 

Windows 11 

23h2(64 bit) 

Windows 11 

23h2(64 bit) 

Windows 11 

23h2(64 bit) 

Java JRE JRE 1.8.0_451 

 

JRE 1.8.0_461 

(TBC) 

JRE 1.8.0_471 

(TBC) 

JRE 1.8.0_481 

(TBC) 

JRE 1.8.0_431 JRE 1.8.0_451 JRE 1.8.0_461 JRE 1.8.0_471 

(TBC) 

MS Office MS Office 2016 MS Office 2021  MS Office 2021 MS Office 2021 

MS Office 2016  MS Office 2016 MS Office 2021 MS Office 2021 

Identity Agent 

(Smartcard Users 

only) 

NHS IA2.3 NHS IA2.3 NHS IA2.3 NHS IA2.3 

8.1 Key 

Fully 

Supported. 

ESR at the release shown, has been fully tested and is 

supported against the software component. 

Support is 

provided on 

a reasonable 

endeavour’s 

basis 

The relevant ESR release has had limited risk-based testing 

against the software component and proven to work. Support 

will be offered on a “reasonable endeavours” basis and is not 

subject to the usual ESR KPI response times for support calls.  

TBC The version of the relevant software component that will be 

supported is yet to be confirmed. An updated version of the 

document will be issued as soon as a decision is made. 
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9 Appendix B – Workarounds and Alternative Software 

9.1 Multi-Factor Authentication (MFA)  

Users can register their ESR account to use MFA which adds additional security to their 

account for internet access and allows them to reset their password via MFA. 

The supported method for users to register their account is the Microsoft Authenticator 

app. Users can download and install this on their own personal mobile device from either 

the Google Play or the iOS App Store.  

9.2 Multiple Sessions in the Browser 

For organisations who need the use of multiple sessions: 

9.2.1 Chrome 

Chrome allows running multiple browsing sessions using multiple user profiles for web 

based forms. For Java based forms, only a single user session can be launched. 

How to create a new profile:  
1. Open Google Chrome on desktop 
2. Click on the browser profile icon 
3. Click on Personnel Management 
4. Click on Add User 
5. Enter the name of the NEW user 
6. Choose an icon for the user 
7. Check the Create a desktop shortcut for this user box. 
8. Click Add 

A new instance of Chrome with an entirely different profile from the current user, so the 
cookies and the like are not shared. After that, when you launch a new window, you can 
select a user profile to switch between & hence have multiple sessions. 

For professional uses: 
If launching professional forms, only one user session can be used. 
As a single user, you can launch multiple forms for different responsibilities, but you must 
go to preferences and enable this option. 

 

Please note: This is more useful for SSC users who manage multiple VPDs under a single 
user_id. If they have multiple user_ids, then they cannot launch two form sessions 
simultaneously. 
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9.2.2 Edge 

Similar to Chrome, to create a new profile in Edge, click the profile icon to the right of your 

address bar and click “Add a profile”. Then, on the consent screen that comes next, just 

click “Add”. 

Switching between profiles You can switch between profiles any time by clicking on the 

desktop icon or window associated with a profile  

 

9.3 PDF Reader 

The following settings may need to be made within Internet Options to enable reports in a 

PDF format to be viewed 

• Select Tools → Internet Options → General, in the Browsing history' zone select the 

'Settings' button 

• In 'Settings' pop-up window Set 'Check for newer versions of stored pages:' to 

''Every visit to the page ' (NOT 'Automatically ') 

 

9.4 Google Chrome 

Some users have reported issues accessing ESR via Chrome. The issue is related to an 

existing local policy to block all third-party cookies configured in Chrome. To solve this: 

 

• Open Chrome. 

• At the top right, click “More”  and then “Settings”. 

• Check that cookies are not blocked for the 3rd party websites “@esr.nhs.uk” and 

“trustedurl.national.ncrs.nhs.uk. 
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10 Appendix C - Troubleshooting 

10.1 Networking 

Common problems encountered during connectivity  

1) Web Browser settings where use of proxy server is made compulsory will give 

problems. 

2) Inability of the site to resolve hosts in the “.cdn.esr.nhs.uk” or “my.esr.nhs.uk “ domain 

i.e. this should be achieved through the main BT DNS’s on HSCN. Alternatively an 

entry for the “.cdn.esr.nhs.uk” or “my.esr.nhs.uk “ can be made in the local NHS 

Organisation’s DNS’s using BT DNS’s on HSCN as forwarders.  

3) Ensure BTN3SP has provisioned the required routing entry to gain connectivity to the 

ESR supplier network. This is pertinent to sites that have not used the ESR supplier’s 

services before. 

10.2 Remote (VPN) Smartcard Access to ESR  

NHS England have confirmed that users are able to authenticate onto NHS CRS (Care 

Records Service) via VPN. If users can authenticate onto NHS CRS within the workplace, 

but are unable to do so when connecting via a VPN, the VPN is a probable cause.  

The NHS England Deployment Issue Resolution (DIR) Team have confirmed that DNS 

name resolution, firewall rules and routing are common problems that may prevent remote 

authentication onto NHS CRS via a VPN. Further details below have been provided by the 

NHS England DIR team:  

DNS: Users will need to be able to resolve the DNS names of the relevant SPINE 

interfaces to IP addresses while on the VPN. Local IT teams should ensure users can 

resolve gas.national.ncrs.nhs.uk and sbapi.national.ncrs.nhs.uk . Organisations should 

ensure that any local DNS are resolving the address using the HSCN IP address, and not 

the W3 address. 

 

1) Firewall rules: Organisations need to ensure that access is available to 

https://gas.national.ncrs.nhs.uk/ and https://sbapi.national.ncrs.nhs.uk/ on port 443.  

2) Routing: Organisations need to ensure the SPINE servers are able to route traffic back 

to the VPN endpoint. If Network Address Translation (NAT) is performed on the 

inbound connections traffic may not get back. Consideration should also be given to 

where the VPN breaks out within the local network versus where the HSCN connection 

is 

Organisations should direct queries regarding VPN configuration to allow remote 

authentication onto NHS CRS to the NHS England DIR Team via dst@nhs.digital.nhs.uk. 

The NHS England ‘remote access good practice guidelines’ should also be considered 

when providing users with remote access to the HSCN network.  

file:///C:/Users/bryan.wood/Documents/dst@nhs.digital.nhs.uk
https://digital.nhs.uk/services/health-and-social-care-network/hscn-technical-guidance/business-applications-guidance/government-guidance
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The NHS England Technology Office have also issued the following steps to troubleshoot 

the ‘Page cannot be displayed’ screen when attempting to authenticate. 

1) DNS: Organisations need to be able to resolve the DNS names of the relevant SPINE 

interfaces (below) to IP addresses while on the VPN. This will either mean static host 

file entries, or you will need to enable split DNS or fully tunnel all DNS to an internal 

DNS server that can resolve these addresses. Ensure you can resolve 

gas.national.ncrs.nhs.uk and sbapi.national.ncrs.nhs.uk. 

 

2) Firewall rules: Organisations need to ensure that access is available to 

https://gas.national.ncrs.nhs.uk/ and https://sbapi.national.ncrs.nhs.uk/. That will mean 

opening port 443 to these addresses at least. There may be others, and you may have 

to do a bit of trial and error (using the firewall logs) to find out what else they are 

accessing. You can’t ping these addresses but can check access easily by using ‘telnet 

155.231.48.140 443’ to see if you get a connection (which will look like a black screen 

with a flashing cursor) 

 

3) Routing. The SPINE servers will need to be able to route traffic back to the VPN 

endpoint. Unless you are doing some kind of NAT on the inbound connections (or 

assigning a local address via an IP-POOL) the traffic may not be getting back. You’ll 

need to think about where your VPN breaks out into the local network, vs where your 

HSCN Connection is. Use ‘tracert 155.231.48.140 -d’ from the VPN endpoint and see 

how far your traffic is getting. If it stops at a router you own, there may be an issue with 

your configuration. 

 

  

https://gas.national.ncrs.nhs.uk/login/authactivate
https://sbapi.national.ncrs.nhs.uk/saml/RoleSelectionGP.jsp?token=%3cSSO_TICKET%3e&selectedRoleUid=%3cROLE_UID%3e&ssbMode=%3cMODE
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11 Appendix D – JRE Deployment 

11.1 JRE Conflicts 

Newer versions of JRE are normally backwards compatible with applications requiring 

older JRE versions. However there may be certain applications where a specific version of 

JRE is required to ensure correct operation. Whenever a change to the supported version 

for ESR is announced, organisations are encouraged to test the newer version against 

business critical applications in advance of the ESR implementation.  

 

11.2 JRE Licensing 

In 2019, Oracle introduced new licensing arrangements for Java and JRE for users of non 
Oracle systems, there is now a licence fee for Java.  
 
However, the ESR service is built on the Oracle HRMS e-Business suite product. That 
Oracle product requires the end user device to have JRE installed. As stated in the excerpt 
below which is taken from the following webpage :-  

https://www.oracle.com/technetwork/java/javase/overview/oracle-jdk-faqs.html,  

users of systems that Oracle supplies such as ESR (Oracle HRMS) are entitled to a free 
JRE licence.  
 

“I am a customer of an Oracle Product that uses Java. Does Oracle Java remain 

free for me? 

If you are a customer who has a current support entitlement to any Oracle Product 

that includes Java, you continue to have free access to any Oracle Java SE 

updates for use with that Oracle Product.” 

 

11.3 Essential Installation Considerations 

11.3.1 Java 

For normal running of ESR the PC user must have write permissions to the JRE cache. To 

check this: 

• Select Java icon in control panel -> Select General tab. 

• Select settings in the Temporary Internet Files section. 

• This path must be writable to the user. 

 

11.3.2 JRE Auto-Download 

By default Java is configured to download the latest version of JRE to the desktop. To 

ensure no higher than the recommended version of JRE is used, it is recommended that 

https://www.oracle.com/technetwork/java/javase/overview/oracle-jdk-faqs.html
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the automated download of higher JRE versions is disabled. This can be achieved by 

following the steps below. 

1) Click Start => Control Panel and double click on the java control panel. 

2) Within the Update tab unset the Check for Updates Automatically option (Figure 9). 

3) Click Apply to save the setting. 

 

 

11.4 Mechanisms to upgrade desktops 

JRE can be distributed in many ways and this will vary greatly from organisation to 

organisation, details are given below on suggested methods. This list is not exhaustive 

and local IT departments may choose to use the advice given here or to integrate with 

existing software deployment technologies or procedures. 

Please note: admin rights will be required on a client in order to install JRE. 

For each option below, reference must also be made to the “Essential Installation 

Considerations” section. 

 

11.4.1 Manual Installation 

It is possible to visit each PC and manually install JRE by simply copying the installer to 

the PC and following the suggested instructions. 

 

11.4.2 Automated Distribution Tools 

Many organisations will have existing desktop management and deployment tools and 

JRE lends itself well to inclusion in such methods. 

  



 

 

MM-0100 – Organisation Site IT, Printer and Network Infrastructure Readiness v46.0 Page 28 of 41 

RESTRICTED - IBM ESR Programme Staff & NHS ESR Programme Staff and NHS Employing Organisation 

ESR Users only 

11.4.3 Logon Scripts 

It is possible that any organisations using windows logon scripts to include the download 

and installation of JRE (from a local server) into the logon script as a one-time option.  

12 Appendix E – FTP Protocols 

ESR recommends FTP over TLS. 

FTPS 

This is the standard encryption extension for FTP, defined by RFC 4217. 

ESR supports: 

• passive FTP transfers compliant with RFC 4217 encryption; 

• FTP over TLS; 

• encryption for both authentication and data; 

• use of self-certification on your FTP server. 

ESR does not support: 

• implicit FTPS ('port 990') - this is non-standard and obsolete; 

• FTPS without passive connections. 

 

To use FTPS an Organisation will need: 

• an FTP server that supports RFC 4217; 

• an FTP server configured for FTPS transfers; 

• firewall access from the ESR supplier systems to the Organisations FTP server on 

port 21 for control connections; 

• firewall access from the ESR supplier systems to the passive port range defined on 

the Organisations FTP server. 

Typical Windows Products that support FTPS: 

• Windows 2008 Server with IIS7 (commercial product from Microsoft) 

• zFTPServer (commercial version available from http://www.zftpserver.com) 

• FileZilla-Server (GPL licensed) 

Typical Linux and Unix Products that support FTPS: 

• Red Hat Enterprise Linux 9.3, 8.9 and 7.9 (commercial product from Red Hat) 

• CentOS 8 (Community supported Linux) 

• Fedora 38 (Community supported Linux) 

• Any Linux or Unix system that can run the vsftpd or proFTPd FTP server 

Please note that software created before 2006 is unlikely to have any viable support for 

FTPS. 
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SFTP 

This is a sub-protocol of the OpenSSH software found on almost all modern Linux and 

Unix systems. There are a few implementations for Windows. 

ESR supports: 

• sftp transfers transfer using keys; 

• file conversion to simulate FTP ASCII mode; 

• encryption for both authentication and data. 

ESR does not support: 

• sftp transfers using password fallback method. 

To use sftp an Organisation will need: 

• the OpenSSH software or software that incorporates support for it; 

• firewall access from the ESR supplier systems to port 22 on the Organisations 

server. 

Typical Products: 

• Any modern Linux or Unix system 

Network Security 

The ESR source addresses are from network 62.130.47.32/27 and these should be 

allowed through any firewalls. 

For FTPS, firewall access to the following ports is required: 

• port 21 on the Organisations FTP server system; 

• the passive port range as defined on the Organisations FTP server 

The passive port range should be in the IANA ephemeral port range 49152 to 65535 - a 

range of 20-100 ports is typical for a moderately used FTP server. 

For sftp, firewall access to the following port is required: 

• port 22 on the Organisations sftp server system 
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13 Appendix F – Deciding on Supported Versions 

13.1 How the decision is made on which versions to support 

Given the size and complexity of testing ESR, it is not feasible to test ESR against all 

versions of software whilst maintaining the current level of change to the functionality in 

ESR. Ahead of each quarterly development and testing cycle, the supported software to 

be used during the development and test is agreed. On successful conclusion of the 

development and testing cycle for an ESR release, the development and test platform will 

become the supported platform for ESR at the point that the release is deployed into 

production.  

To support the decision process and in order to reduce the impact of change on the NHS, 

a yearly survey of ESR users is carried out to understand current software deployments 

and planned software upgrades across the NHS. The results of the survey form a 

significant factor in deciding the supported versions, as wherever possible they will be set 

to reflect the versions most commonly in use across the NHS. 

The current table of software requirements is based on data received from the last ESR IT 

System Survey carried out.  

The next survey will be carried out during the last quarter of the calendar year. 

 

13.2 ESR Portal tested devices 

The following table lists the platforms that were used for the development and test of the 
ESR Portal and associated ESS/MSS functionality which are now supported against ESR.  

Platform Format Device Browser 

Android Tablet Samsung Galaxy Tablet Default Browser 

Android Phone Samsung Galaxy S10 Default Browser 

Android Phone Samsung Galaxy S23 Default Browser 

iOS Tablet iPad Air Safari 

iOS Tablet iPad Safari 

iOS Phone iPhone 13 Safari 

iOS Phone iPhone 6s Safari 

Windows Desktop N/A Microsoft Edge 

Windows Desktop N/A Firefox 

Windows Desktop N/A Chrome 

Windows Desktop N/A Safari 
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14 Appendix G – Accessing ESR via Microsoft Edge 

14.1 Introduction 

14.1.1 Scope and Purpose 

This section aims to detail the changes required to enable ESR and related smartcard 

reader software to work together to authenticate users using modern browsers.  

 

14.1.2 Background 

Prior to ESR Release 53 (March 2022), the only browser that is a supported method of 

either accessing ESR professional forms, and/or authenticating with a smartcard is 

Microsoft Internet Explorer 

This is because both ESR and the NHS Identity Agent use Java Applets (via the NPAPI 

plugin) to launch the required functionality. 

Most modern browsers no longer support Java applets and applets were completely 

removed from Java in later versions. In addition, Microsoft announced in 2021 that support 

for Internet Explorer 11 would come to an end on 15th June 2022. 

Therefore, a number of changes were progressed to ensure both Smartcard 

Authentication and ESR Professional forms can launch successfully on browsers other 

than IE11, specifically Edge (Chromium) and Chrome. The two largest changes are: 

• NHS England development of NHS Credential Management (to allow authentication 

without Java applets using a locally hosted web server instead) 

• Enablement of Java Web Start in ESR (to allow Java forms to be launched without a 

Java applet). 

 

14.1.3 NHS Credential Management 

The NHS Credential Manager developed by NHS England is an alternative method of 

communicating with a smartcard in order to authenticate a user. NHS England decided to 

create an application which creates a self hosted local web server in order for other 

systems (e.g. ESR) to communicate with it. This application is called NHS Credential 

Management and replaces all Java applets currently used by the NHS for authentication. 

Installed along with NHS Credential Management application (in the same installer) is the 

NHS Port Service, which allows NHS Credential Management to be used on machines 

with multiple users logged in at once (ie: Terminal Services, Citrix, fast user switching 

scenarios etc). 

Further details of NHS Credential Management can be found in the user guidance 

available alongside the download link in the required software section later in this 

document. 
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14.1.4 Java Web Start 

Java Web Start (JWS) is an alternative method of initiating Oracle Java Forms which has 

been enabled in ESR. Previously a Java applet was executed within the browser, and from 

there the full Java application was launched. 

Java Web Start works differently – when the user wishes to launch a Java Form in ESR, a 

file will be downloaded in their browser with the extension .jlnp. By default, .jnlp files are 

associated with Java when Java is installed on the client machine. Therefore, when the 

user opens the .jnlp file, it will launch the Java application – in this instance, an ESR 

professional Java based form. 

From ESR Release 55, JWS is now the default method of launching Java forms. 

 

14.2 Security Considerations 

14.2.1 Private Browsing 

Users should be aware that private browsing may not work with Microsoft Edge. 

 

14.2.2 Removal of Smartcard during a session 

Users should be aware that the removal of the smartcard from the device does not close 

the active session in ESR. Users need to log out of ESR before removing the smartcard. 

14.3 Software / Network Requirements 

14.3.1 Summary 

The following high level steps are required in order to ensure the client machines are able 

to read a smartcard to communicate with ESR, as well as launch forms in ESR using a 

browser other than IE11. Organisations should ensure: 

1) Identity Agent v2.3 or above is installed and configured (Section 14.3.2 below) 

2) Trusted URLs are allowed through any proxy or firewall software (Section 14.3.4.1 

below) 

3) A minimum of Java JRE version 1.8.0_261 is installed  

4) Configuration is applied to browsers to ensure jnlp files are automatically 

downloaded and executed when accessed from ESR (Section 14.3.4.2 below) 

 

14.3.2 Smartcard Reader 

The following software is required to ensure ESR can communicate with the smartcard 

reader: 



 

 

MM-0100 – Organisation Site IT, Printer and Network Infrastructure Readiness v46.0 Page 34 of 41 

RESTRICTED - IBM ESR Programme Staff & NHS ESR Programme Staff and NHS Employing Organisation 

ESR Users only 

1) NHS Credential Management (this includes the NHS Port service) 

2) NHS Identity Agent v2.3 or above 

Both of these can be downloaded alongside user guidance from NHS England here. 

 

14.3.3 Professional Forms 

No other additional software is required to ensure ESR professional forms will launch 

correctly from browsers other than IE11, however JRE version 1.8.0_261 is the supported 

version tested to ensure compatibility as per the MM-0100 document (available on the 

ESR Hub). 

 

14.3.4 Configuration 

14.3.4.1 Networks 

Organisations should ensure that the following address is allowed through any local 

firewall or proxy services: 

trustedurl.national.ncrs.nhs.uk 

If this address is blocked, this may be evident in the file at the address below: 

C:\ProgramData\HSCIC\NHS Port Service\NHSPortService.log 

To test, organisations can attempt to access the following address which should initiate a 

file download: https://trustedurl.national.ncrs.nhs.uk/api/versioninfo 

 

The file that is downloaded can be ignored, but a successful download means that the 

connection was established.” 

14.3.4.2 Browsers 

Rather than requiring the user to open the downloaded .jnlp file from the browser, it is 

possible to configure the browser to automatically open these files. 

Microsoft Edge has the registry entries below that control the behaviour: 

[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Edge\AutoOpenFileTypes] 

[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Edge\AutoOpenAllowedForURLs] 

[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Edge\ExemptDomainFileTypePairsFrom 

FileTypeDownloadWarnings] 

 

These can be set as below to ensure the jnlp files are opened automatically to make it 

easier for users to launch the Java forms: 

[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Edge\AutoOpenFileTypes\ Value Name: 

1 

https://digital.nhs.uk/services/screening-services/national-cervical-screening/new-cervical-screening-management-system/actions-for-local-it-teams
https://trustedurl.national.ncrs.nhs.uk/api/versioninfo
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Value: jnlp 

[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Edge\AutoOpenAllowedForURLs] Value 

Name: 1 

Value: my.esr.nhs.uk 

[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Edge\ExemptDomainFileTypePairsFrom 

FileTypeDownloadWarnings] 

Value Name: 1 

Value: {"domains": ["my.esr.nhs.uk"], "file_extension": "jnlp"} 

 

Screenshot examples: 

 

 

 

You can check these policies are being applied in Microsoft Edge by opening the address 

“edge://policy/” within edge itself. You should then see the policies in place: 
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14.3.4.3 Downloading Reports 

When downloading reports from ESR Professional Forms (not via ESR BI) users may get 

an ‘Authentication Failed’ message. This is due to a setting in Edge which tries to open 

any MS Office object in the browser rather than in the native Office application. The ‘Open 

Office files in the browser’ setting below in Edge must be disabled to allow these reports to 

be opened correctly: 

 

 

14.3.5 Testing 

In order to authenticate a user using their smartcard using a browser other than IE11, you 

must have the following installed and running: 

1. NHS Port Service 

2. NHS Credential Management Software 

3. NHS Identity Agent 

To test whether the authentication is working correctly, the address below can be used. 

Care Identity Authentication (spineservices.nhs.uk) 

https://am.nhsidentity.spineservices.nhs.uk/openam/XUI/#/smartcardDiagnostics
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14.3.6 Launching Java Forms 

Since ESR Release 55, ESR uses a method of launching Java Forms by downloading a 

file. The following table shows the process the user will follow to launch the forms. 

 

Step Description Screenshot 

1 Navigate to the required 

form (Enter & Maintain in 

this example) 
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2 A file will be downloaded 

with the extension .jlnp. 

This will occur every time a 

Java form is launched, 

therefore it is preferable to 

implement the changes in 

section 2.3.2. to ensure the 

download is opened 

automatically. 

Note: Depending on the 

browser, this may be 

blocked. As in this 

example, you may need to 

click ‘See more’ and select 

‘Keep File’ 

 

 

3 Open the file 

 

 

 

 

4 A Java window is displayed 
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5 The form is then displayed 

 

 

14.4 Backwards Compatibility 

14.4.1 Smartcard Software 

NHS Identity Agent v2.3 is backwards compatible with IE11 as well as working with non-IE 

browsers such as Edge and Chrome, therefore this may be installed in readiness for using 

the new Java forms launcher without any impact on the user’s ability to access the forms. 

The new Java forms launcher itself is expected to work with IE11 (although this 

configuration is not supported). 

 

14.5 Troubleshooting 

14.5.1 Common Resolutions 

The following issues have been seen previously with suggested resolutions. 

 

 

1) NHS Port Service will not start 

Should this occur, stop the Credential Manager and Port Services, try deleting the files 

below from this directory: “C:\Program Files (x86)\NHS Digital\NHS Port Service” 
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• PortStore.txt 

• DomainList.txt 

Restart the services and try again. 

 

2) Users receive an ‘Authentication Failed’ message when attempting to download a report 

from ESR Professional Forms.  

Please see the Configuration section above with sub-section ‘Downloading Reports’. 

 

14.5.2 Support and Feedback 

Should you have any issues with implementing the changes required as detailed above, 

please raise a service request (SR) with the ESR Service Desk, fully detailing the problem 

and ensuring you take a note of the SR number. 

 

14.5.3  Accessing the Portal Staging environment via Edge 

 

Some users have reported that they are unable to access the Portal Staging Environment 

via Edge running in Compatibility Mode. Edge should be used in native mode to access 

the staging environment. 
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